X-Analysis Data Management
[image: image57.png]






X-Analysis
Data Management

Tutorial

This product requires a security code to activate it.

For Security Code, please call Databorough on 

N.America: (705) 458 8672 

Europe:  (44) 1932 848564 

Alternatively contact Databorough by email at: 

support@databorough.com  

or 

info@databorough.com
Information in this manual is subject to change without notice and does not represent a commitment on the part of Databorough Limited.  The software described in this manual is furnished under a license agreement and may be used or copied only in accordance with the terms of the agreement.

©  Copyright 2005 Databorough Ltd.  All rights reserved.

Databorough Ltd, Beacon House, South Road, Weybridge, Surrey, U.K.  KT13 9DZ.

Telephone:  Weybridge (01932) 848564.  Facsimile:  Weybridge (01932) 859211.

Table of Contents

2Table of Contents


3What’s in this Tutorial


4Capitalising on the Data Model


4Application Data Model


7Application Area Concept


8Working with X-Browse


8Working with Data Dictionary


12Working with Data


15Working with Application Areas


16Adding an Application Area


18Updating an Application Area


18Removing an Application Area


18Adding Objects to an Application Area


21Work with Objects


22X-Verify


22Verify Data Relationships


22XVERIFY command


23Viewing the Report


24X-Subset


24Set Subset/Archive Filter


26Subset Data


26XSUBAREA command


27Viewing data subset


28Viewing the Report


29X-Archive


29Archive Data


29XARCAREA command


30Viewing Archive data


31Reinstate Archived records


31Individual record reinstatement


32X4WRKAPP Master Control


32Work with X-Analysis/4 Applications


33Journal Enquiry


33Pre-requisites


33Work with Journaled records




What’s in this Tutorial

This tutorial describes the additional capabilities of the X-Analysis product set. These facilities make further use of the Data model & Cross-reference library already created by X-Analysis. The extra product modules include:

· X-Browse - Data Enquiry & Data audit tool driven by the reverse engineered DMD.

· X-Verify - Verifies the integrity of existing data against the reverse engineered data relationships.

· X-Subset - Produces test datasets using user defined selection criteria. The integrity of such data is then verified against the DMD and any necessary master records are copied in cumulatively until a completely self-contained test database is produced.

· X-Archive - Uses these same facilities to archive data from top-down user selection criteria (e.g. customer accounts to archive). The data model is automatically interrogated for all necessary dependent record archiving and complex archive requests can be set up for automatic running. A full GUI over the database is provided that allows both specification of the archive selection criteria & also for reinstatement of any records incorrectly archived.

· X4WRKAPP - A master menu of advanced X-Analysis facilities for application subdivision, special program call handling & refinement of the X-Analysis documentation.

Tutorial also highlights the Application areas, the crux of Application Data Management.

So let’s go ahead with the tutorial and examine the additional capabilities of the X-Analysis product.

Capitalising on the Data Model

The complete data model accurately describing all possible relationships between each file can be used very effectively for productive maintenance and development work.  Such a model can also provide the foundation upon which business intelligence, data analysis, and data archiving can proceed (Refer to sections on X-Verify, X-Subset and X-Archive).

X-Analysis is unique in that it automatically derives the system data model by analyzing both the actual data contents and all programs that use this data to verify the existence of any cross-file relationships. These potential relationships are then verified by performing an integrity check to ensure that all data from the dependant file does indeed validly reference data records from the owning file. In this way even the most complex legacy system can be data modeled with relatively no effort.

Let us now examine an application data model in X-Analysis.

Application Data Model

To bring up the Data Model Diagram for the XAN4CDXA – XAN4CDEM Application do the following:

· Select the XAN4CDXA – XAN4CDEM Application to work with.
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Application Libraries view

	· Click the DMD button on the toolbar. This brings up the DMD dialog.

· Select Re-generate DMD Data and click OK.

This will generate the DMD for the whole system.
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Data Modeling Diagram dialog


The resulting screen shows the relationship between the various files in the XAN4CDEM application.
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Data Model Diagram of XAN4CDEM Application

X-Analysis shows the data model as an interactive diagram. This data model is generated by another Databorough product called X-Rev. All relationships are shown by default, but if required, file centric or application area specific filtering of the diagram can be induced by simple point & click mechanisms. The exact nature of the relationships between each entity is colour coded and described in the detail view. A detailed report describing the data model can also be produced, which can be printed if required.

Click on the CUSTS file. This shows the relationship between CUSTS and the related objects.
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DMD of XAN4CDEM Application with CUSTS selected

Double-click on CUSTS to better understand the DMD relationships for CUSTS file.
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Data Model Diagram of CUSTS File

With CUSTS in the middle, we get a much clearer picture of how the objects are interrelated.
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	Look at this picture showing three lines protruding from CUSTS (encircled). These lines connect CONHDR, PROJECT and TRNHST. Click on one of these points, say the one connecting TRNHST. It brings up the File Connection details dialog telling that TRNHST accesses CUSTS by fields XWBCCD. XWBCCD is the primary key of CUSTS file. It thus indicates that CUSTS has three dependents.
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File Connection Details

	Further, the lines with the crowfoot on CUSTS, four in number, suggest that CUSTS is dependent to four files, viz., CUSF, SLMEN, CUSGRP and DISTS.

The File Connection details for the CUSTS DMD details as to how the files accesses each other and through which field.




Individual files can be selected to display relationships pertinent to the selected file only. The detail of each relationship can be displayed, and the underlying data is stored in a structured relational database for easy reporting/analysis. A data model diagram is, by its very nature, extremely complex when produced for an entire application, thus it is necessary in such circumstances to logically subdivide an application into areas.

The diagram can be exported to MS-Word or Visio, and a DDL version of the entire Data Model exported to tools such as CA's - All Fusion, System Architect, Microsoft SQL Server or Oracle.

Application Area Concept

X-Analysis creates application areas from part of one or multiple systems. It is possible to programmatically subdivide an application into logical modules or areas.  This can be within the context of a single system e.g. order entry from the operational system, or indeed specific parts from multiple systems e.g. Order Entry from the operational system and sales ledger from the financial system.

The entry of powerful user-defined rules combined with information about the entire application that is stored in the X-Analysis repository are applied by X-Analysis to make this an instant and repeatable task. These application areas can then be used to accurately and confidently put a ring around all objects impacted and required from projects such as re-engineering, re-development, replacement or project management allocation of development responsibility.

· Click on the DMD button on the toolbar to bring up the DMD dialog.

· Pick SALES Application area and check the Display External Relationship option.

The DMD thus produced is shown below.
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DMD on SALES application area with external relationships

The DMD shows a few files in yellow and the remaining files in blue. As the DMD legend says, the files in yellow are Internal, i.e. belong to the SALES application area. The files in blue are external.
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DMD legend

This implies that the files in yellow, viz., PROJECT, CONDET, CONHDR, TRNHST, CUSTS and SLMEN are grouped under the application area SALES. All other files of the application are external to the SALES application area.

Thus we deduce that the Application area facilitates the grouping of an application into different Business Areas, thereby making it easier to understand and maintain the Application.

For more details regarding application areas, refer to the Working with Application Areas section of this tutorial.

Working with X-Browse

X-Browse is a Data Enquiry & Data audit tool driven by the reverse engineered DMD. X-Browse can be invoked from X-Analysis, provided it’s installed on the machine. Let us see how.

Working with Data Dictionary

The Data Dictionary contains detailed information for every field in each file in the application database. Much of this data is the standard metadata extracted for each file and stored on the XDD file - for instance field and column names, field size and field type. Thus record metadata is readily available for use by other applications.
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	Click on the Data Dictionary button on the tool bar. 

Alternatively, you may also select Action > Invoke X-Browse for Data Dictionary.



The X-Browse Data Dictionary is displayed, presenting the Primary Identifiers view.
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X-Browse Data Dictionary – Primary Identifiers

The Databorough data model describes an application database in terms of its structure and how the database is used by an application. The data model itself is held in five files:

· A list of every field in each file in the application database (XDD),

· A list of the primary identifiers (XPIDS),

· A list of the file access paths (XKEYMAP),

· A list of the relationships between files (XRELS) and

· The description of how files are joined together (XSHKEYS). 

List of Primary Identifiers (XPIDS)

Go to File menu in X-Browse and select Entities. The Primary Identifiers view is displayed. This is also the default view when the Data Dictionary is invoked from X-Analysis.

The identification of the correct primary identifier is crucial to the building of an accurate data model. The primary identifier is determined by an examination of all the access paths for the file and is verified against the data in the file. All the primary identifiers are written to the XPIDS file.

List of Fields (XDD)

Go to File>Fields.
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Data Dictionary – File Fields

This view gives information for every field in each file in the application database.

Some of the important columns in this grid are as follows:

	Field Name
	Field Description
	Possible Values

	Field Names
	Names of Fields in the Database
	

	PF Name
	The Physical File containing the Field
	

	Type
	Field Type
	D=Descriptor, W=Computed, T=Totallable

	Date Format
	
	T=Time, U=User defined time, D=Date type, 6=6 Numeric, 7=7 Numeric etc

	Word Processing Type
	
	An=Address, Nn = Name, Tn = Title 


List of File Access Paths (XKEYMAP)

Go to File>Access Paths.
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Data Dictionary – Access paths

The XKEYMAP is built for each file, storing access path information for each physical and logical file in the database. Up to 10 key fields can be associated with each field.

List of the Relationships between Files (XRELS)

Go to File>Relationships.
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Data Dictionary – File Relationships

There are three types of relationship that can be identified:

· Owns – PID to PID relationship

· Accesses – Access Path to Access Path relationship

· Refers to – foreign key to PID relationship.

Details of all relationships are written to the XRELS file.

	Field Names
	Field Descriptions
	Possible Values

	OWNPF
	Owning PF
	

	OWNTXT
	Owning PF Text
	

	DEPPF
	Dependent PF
	

	DEPSEQ
	Dependent PF Sequence No.
	

	DEPTXT
	Dependent PF Text
	

	DEPLF
	Dependent LF
	

	RF ONLY
	Reference Only
	Y=Ref.Only  O=Owns  D=Dependents Only

	ORIGIN
	Origin
	S=Synon

	OWNLF
	Owning LF
	Normally blank = Use PID


	RELID
	Relationship ID
	

	R1T1
	1 to 1 Relationship
	


Description of how Files are joined together (XSHKEYS)

Go to File>Relationship Details
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Data Dictionary – Relationship Details

For every relationship, the precise nature of the join between the two files (the join rules) is written to the XSHKEYS file.

	Field Names
	Field Descriptions

	FILE
	File

	MFILE
	Match File

	KSEQ
	Key Sequence

	FLD
	Field

	MFLD
	Match Field

	CONST
	Constant

	RELID
	Relationship ID


Working with Data

Bring up the Data Model Diagram for the file CUSTS in the XAN4CDXA - XAN4CDEM Tutorial System. Click the DMD button on the toolbar.
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Application Libraries view

This brings up the DMD dialog. Enter CUSTS in the Object field. Select Re-generate DMD Data and click OK.
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Data Modeling Diagram dialog

The resulting screen shows the relationship between CUSTS and its related objects.

The object specific DMD is presented in the detailed form as for CUSTS below.

[image: image18.png]File Comacrion beratls
— 1 cONDR  Accerser CUSTS by fields:  mCOD.
D ocome  heeesser cust by fiesds  cusm.
3 CUSTS  Acoerser CUSGRP by fialds:  VENCD.
4TS emerser DISE by ieldrs Dok
A 5 CUSTS  Acceeser MSTS by aelas:  bConk
© MO  ecerser CUTE by eld  me.
= 7 CUSTS | Accerser FTVRES by fialas:  DCGDE
© TS ecerse SN by Geld  Dmson
5 TmmST  Accerser CUSTS by tialas mcod.
i & Mt Qe To
| | Ay
ooy Chonges | ClearFom_| 5| 4 4 ]





Detailed DMD for CUSTS

	Click on the CUSTS object to select it, and then click on X-Browse button  on the toolbar. Alternatively, select View Data option on right-click popup menu on CUSTS.


	[image: image19.png]





[image: image20.png]i Von Lovusey Acns Oepndns Fhas Do iyt

rlvlz tho‘d“il 5| § | oron o o v w6

3_Cotone [ one [ S s Cotip | Db Pospctt] st icers] Tseg]_Brk | sk i Frs
=) s e T 1 S (B 7 RV
5 Seekitaia s " F—
P [ & o i -
s B trreeralis ] i} LT
it Bomeesiioe B ‘ ¥ R
S s B o -
S NeleFoos ¢ & 5 -
R s ot S AT o % o L —




CUSTS records as grid on X-Browse

Explore the various access paths (logical files-LFs) under LookupBy menu. The grid is presented on the basis of keys specified for LFs.

Double click on the first record to go to the single record display.

[image: image21.png]e R
e ‘,ﬁ' 3 | 5] sarires s v

il

- T e @ e E
- f— s R
- —— oy
— R -
o e -
P oy =
e outer w F
e e M - i
R o
T cremon 7 s T T T —Toen e Ty Ty —Toint
e e e — i g
pr . R 5T R v Vet





CUSTS single record display

The single record display presents the selected record’s display and it’s dependents as tabs.

Opt for View > Dependent Functions on Record display if dependent grid is not presented.
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File connection details on the detailed DMD for CUSTS

The first tab is selected by default and displays the dependent records for the selected record. The three dependents are viz., Contract Header (CONHDR), Projects (PROJECT) and Transaction History (TRNHST). This can very well be interpreted by looking as the File connection details on the detailed DMD for CUSTS above. CONHDR, PROJECT and TRNHST accesses CUSTS by field XWBCCD (Customer), which is CUSTS primary key.

Working with Application Areas

On the Application Libraries view, do the following:

· Expand the XAN4CDXA – XAN4CDEM Tutorial System.

· Select ORDERS – Order Entry System application area.

· Click the DMD button on the toolbar.
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Application with its application areas

· This brings up the DMD dialog. Note the selected Application area is pre-filled. Select Re-generate DMD Data and click OK.
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Data Modeling Diagram dialog

Application area can also be picked using the Name dropdown on the DMD dialog.

· The DMD view shows the relationships among the objects falling under the ORDERS Application area.
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DMD of the objects under ORDERS application area

· Click on the DMD button on the toolbar. This brings up the DMD dialog. Select SALES Application area on the Name dropdown. Click OK. DMD presents a different set of objects this time.
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DMD of the objects under SALES application area

Comparing the output of the two DMDs, we can very well understand the significance of Application areas.

Let us see how the Application areas are maintained.  

	Adding an Application Area

On the List of Application Libraries display (this is the first screen you will see when starting up X-Analysis for Windows), right-click on the XAN4CDXA  Application library. Select the New Application Area option. This brings up a dialog to add a new Application area to the selected Application. The dialog presented prompts for Application Area name and description. On OK the new Application area is added to the Application.
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Add Application Area Dialog
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New Application Area added

[image: image57.png]
The right-click menu on the Application area presents the following options:

	· Update Application area

· Remove Application area

· Application Area Rules
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	· Generate X-Browse Application

· Derive Business Rules

· Re-engineer Business Rule Programs & Screens

· Generate JSF, Javabean(s) and UML


	

	· Export as XMI

· Export as DDL
	

	· Work with objects

· Document Application Area

· Verify Data Relationships

· Set Subset/Archive Filter

· Subset Data

· Archive Data


	

	· 
	Application Area right-click menu option


Updating an Application Area

Right click on the selected application area and select the option Update Application Area. This brings up a dialog to update an existing Application area under the selected Application. The dialog prompts for modifying the Application Area description. On OK the changes are reflected to Application area.

Removing an Application Area

Right click on the selected application area and select the option Remove Application Area. This prompts for confirmation before deleting the application area. If confirmed, it deletes an existing Application area under the selected Application.

Adding Objects to an Application Area

To add objects to the CUSCARE application area, we need to bring up the Object list having CUSTS file. Click on the Object List button on toolbar. Pick Application area as *NONE and set the object name to be CUSTS, as shown on the dialog. Click OK.
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Work with Objects dialog

The object list is presented with CUSTS object.
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Object List with CUSTS Object

	Right click on the CUSTS file and opt for Add to Application area with Related Objects option.
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This option presents the dialog as shown. 
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Add to Application Area with Related Objects

Select the following options:

· Application area – CUSCARE.

· Include cascading set of dependent files.

· Include cascaded set of owned files.

· Click on the Select button. This adds the objects to the application area fulfilling the criterion. The following message appears on the status bar : “Object and its related objects added to Application Area”.

Now repeat the above steps to add another Application Area and add Objects to it: 

· Return to the Application libraries view.

· Create another application area in the name TRANS – Transactions.
· Bring up the object list having TRNHST object as done for CUSTS.

· Right-click on TRNHST object and opt for Add to Application area with Related Objects. Opt for Include cascaded set of owned files only. Click on the OK button.

· The objects to be placed in any Application Area may also be decided by setting the Application Area Rules. The third option on the right click menu over any Application Area opens up the Application Area Rules Dialog. Set the rules for the application area and click on the update button to view the changes by bringing up the object list for that application area.

The feature of setting Application Area Rules has been explained at length in the X-Analysis Application Overview Manual.

Work with Objects

Right Click on the CUSCARE Application Area and select the Work with Objects option. This presents the Work with Objects dialog with the selected Application area, CUSCARE, on the Name dropdown. On OK, an Object list containing objects under CUSCARE application area is presented.
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 Work with Objects dialog

[image: image35.png]Fle Applcation Action View Object

window _Help

=R &|E B BT A% E WD W m

GACDEN
FFGACDEM
LFian4CDEM
LFian4CDEM
LFcan4CDEM
FFcAn4CDEM
LFian4CDEM
LFian4CDEM
LFian4CDEM
LFian4CDEM
LFian4CDEM
LFcan4CDEM
FFcAn4CDEM
LF % AN4CDEM

CONDET
CONDETLL
CONDETL2
CONDETLS
CONHDR
CONHDRLL
CONHDRLLA
CONHDRLZ
CONHDRLS
CONHDRLY,
CONHDRLS
cusF
CUSFLL

Sitrbute

Pr
I
I
I
PE
I
I
I
I
I
I
PE
F

Contract Detal
by Store/Contract{Product
by Store/Contract{Product
by Product/Contract
Contract Header

by Debtor/Contract

by Debtor/Cust Ref

by Rep/Contract

by DebtarfDate

by Debtor/DateRep

by Date

Sites,

Sites by Name.




Object list of objects in CUSCARE Application area

Other right-click menu options on Application area have been taken up in separate sections.

X-Verify XE "X-Verify" 
	Verify Data Relationships

Right click menu option on a selected application area, Verify Data Relationships, brings up a dialog showing the selected X-Ref Library and Application area. It prompts for Maximum records to be printed for each relationship. This can range between 1-999. If the request is successful, the message, “Verify Data Relationships” job submitted successfully, appears on the status bar.

Opt for Verify Data Relationships on SALES Application area. This adds a sub-item by the name Verification to the SALES application area.
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Verify Data Relations Dialog


XVERIFY command

Verify Data Relationships option submits the XVERIFY command in batch. XVERIFY uses the data model constructed by X-Rev to automatically verify that all application data satisfies the relationships deduced by the data model.

The product examines each data record in turn to see if its referential integrity relationships are satisfied. Each integrity relationship that is breached is separately reported on in a comprehensive audit print produced by the product. 

This command is used to verify the data model against the data in the database.

Parameters

The parameters passed internally to the XVERIFY command are:

X-Rev Function Library

The library which contains the data model and application specific files created by the command XDMODEL. This is the name of the library that was entered as the Function Library on the XDMODEL command. Its passed the X-Analysis X-Reference library.

Database Library Name

The library name which contains the application database files. The command is submitted with the value *LOADLIB, implying, each database file should be located in the same library used when XDMODEL was run.

X-Analysis Application Area

The command uses the application area, on which this option is invoked, to control which files in the data model should be verified. Only relationships between files in the specified application area will be verified. Since an application area has been specified, the X-Analysis X-Reference library too is passed as parameter to the command.

Run Mode

Run mode parameter is passed as *REPORT, implying, generate a report showing the primary keys and the foreign keys of each record that breaches a given relationship up to a maximum number for each relationship as specified by the Maximum records parameter.

Maximum Records

If you have selected a run mode of *REPORT then XVERIFY will print a report showing the primary keys and the foreign keys of each record that breaches a given relationship. This parameter allows you to specify the maximum number of records printed for each relationship. 

If a dependent file contains less than the maximum number of records specified (but more than zero records) and all the records breach the relationship then that relationship will also be updated. 

Viewing the Report

Right click on Verification sub-item under the SALES  application area and choose Orphaned Records Report.

This generates a report showing the primary keys and the foreign keys of each record that breaches a given relationship. 
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Orphaned Records Report for SALES application area

X-Subset XE "X-Subset" 
X-Subset module produces test datasets using user defined selection criteria. Let us go through the process of defining selection criteria.

Set Subset/Archive Filter

Right click menu option on a selected application area, Set Subset/Archive Filter, is enabled only if X-Browse is installed. On selection, it starts the X-Browse Port Listener and brings up X-Archive/Subset Filter dialog to add filter on a selected application area.

Case 1

Here we deal with the application area CUSCARE  having objects that are cascaded owners of CUSTS object and objects that are cascaded dependents of CUSTS object. Do the following:

Right click on the CUSCARE  application area and opt for Set Subset/Archive Filter. 
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X-Archive/Subset Filter Criteria Dialog

Since there are no filter criteria specified for an application area initially, the interface opens in Add mode.

· Select the physical file CUSTS from the dropdown.

· For the field  Customer, choose Operator Equal to (EQ) using dropdown.

· Set the Value as ACC1.

· Set the Boolean to OR.

· Add another criteria for Customer = ‘ACC2’.

· Click on the Save button.

· The Return button is now enabled. Click on it to go to display dialog.
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Filter Criteria display dialog

Case 2

This case deals with the application area TRANS having objects that are cascaded owners of TRANS object. Do the following:

· Right click on the TRANS application area and opt for Set Subset/Archive Filter.

Since there are no filter criteria specified for an application area initially, the interface opens in Add mode.

· Select the physical file TRNHST from the dropdown.

· For the field Trn Hst Date, choose Operator Less than OR Equal to (LE) using dropdown.

· Set the Value as 01-11-02 (Date format is DD-MM-YY by default).

· Click on the Save button.

· The Return button is now enabled. Click on it to go to display dialog.

With these filter criterion grouped under the application area, producing the data subsets becomes very convenient. Let us see how.

	Subset Data

Right click menu option on a selected application area, Subset Data, brings up a dialog showing the selected X-Ref Library and Application area. It prompts for test library to hold subset data. If the request is successful, the message, “Subset Data” job submitted successfully, appears on the status bar.

Do the following:

· Opt for Subset Data on CUSCARE Application area.

· The Test Library is initialized to CUSTSS1.

· Click on the OK button. 

This produces the Test library, CUSTSS1, containing the files falling under the CUSCARE  application area. The records on the file obey the Subset Filter criteria specified (as shown above) on the files under CUSCARE  application area.
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Subset Data Dialog


This adds the test library, CUSTSS1  in this case, as a sub-item to the CUSCARE  application area.

Repeat the steps for TRANS application area.

· Opt for Subset Data on TRANS Application area.

· The Test Library is initialized to TRANSS1.

· Click on the OK button. 

This produces the Test library, TRANSS1, containing the files falling under the TRANS application area. The records on the file obey the Subset Filter criteria specified (as shown above) on the files under TRANS application area.

This adds the test library, TRANSS1 in this case, as a sub-item to the TRANS application area.

XSUBAREA command
Subset Data option submits the XSUBAREA command in batch. This command creates a subset of all the files in an application area specified in X-Analysis. It assumes the XDMODEL database is in the same library as the X-Analysis database. It also assumes the name of the group filter to be used is the same as the name of the application area.

Parameters

The parameters passed internally to the XSUBAREA command are:

X-Analysis Application Area

The command uses the application area, on which this option is invoked, containing the files to be subset.

X- Analysis library

The name of the X-Analysis cross-reference library being used, containing the application area definition.

Test Library Name

The name for the test library specified, which this command will create.

Subset Mode

The subset mode is passed as *LIVE, implying, records are copied to the test library if they meet the filter criteria. 

Include owners

This parameter is passed as *YES, i.e. copy records in owning files which own records, which have been copied to the subset.

Rebuild triggers/journals data

This is passed as *NO, i.e. do not rebuild the data. (It the data has already been built then any triggers, journals or constraints will be removed.).

Viewing data subset

To see the records in CUSTSS1  library do the following:

· Click on the CUSCARE Application area to include the CUSTSA1  library created by XSUBAREA command.

· Click on the CUSTSA1  Archive library to make it the default data library. This is reflected onto the status bar’s right most cell.

· Double-click on the Files sub-item under CUSCARE  application area. This brings up the Work with objects dialog.

· Type is pre-selected as *FILE. Select Attribute as PF to restrict the object list to physical files only. Click on the OK button.

· The object list presented contains the files under CUSCARE application area.

· Right-click on the CUSTS file and choose View Data. This opens the CUSTS file in X-Browse displaying the records.
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CUSTS grid

Note the records displayed are for Customer ACC1 and ACC2 only. This meets the filter criteria specified in X-Subset section above for CUSTS application area.

Viewing the Report

Right click on CUSTSS1 sub-item under the CUSCARE application area and choose Orphaned Records Report.

This generates a report showing the primary keys and the foreign keys of each record that breaches a given relationship. 
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Orphaned Records Report for Subset Data Library CUSTSS1

X-Archive XE "X-Subset" 
The Subset/Archive filter facility as descried under X-Subset section is also used to set up complex archive requests for automatic running. A full GUI over the database, as seen above, is provided that allows both specification of the archive selection criteria & also for reinstatement of any records incorrectly archived.

	Archive Data

Right click menu option on a selected application area, Archive Data, brings up a dialog showing the selected X-Ref Library and Application area. It prompts for Archive library to hold the records being archived. If the request is successful, the message, “Archive Data” job submitted successfully, appears on the status bar.

Do the following:

· Opt for Archive Data on CUSCARE  Application area.

· Set the Test Library to CUSTSA1.

· Click on the OK button.

This produces the Archive library, CUSTSA1, containing the files falling under the CUSCARE application area. The records on the file obey the Archive Filter criteria specified (as shown in X-Subset section) on the files under CUSCARE application area.
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Archive Data Dialog


This adds the archive library, CUSTSA1 in this case, as a sub-item to the CUSCARE application area.

XARCAREA command

Archive Data option submits the XARCAREA command in batch. This command archives all the files in an application area specified in X-Analysis. It assumes the XDMODEL database is in the same library as the X-Analysis database. It also assumes the name of the group filter to be used is the same as the name of the application area.

Parameters

The parameters passed internally to the XARCAREA command are:

X-Analysis Application Area

The command uses the application area, on which this option is invoked, containing the files to be subset.

X-Analysis library

The name of the X-Analysis cross-reference library being used, containing the application area definition.

Archive Library

The name for the Archive library specified, which this command will create.

Archive Mode

The archive mode is passed as *RETAIN, i.e. records are created in the archive library if they meet the archive criteria but they are not deleted from the original. 

Include owners

This parameter is passes as *YES, i.e. archive records in owning files which own archived records.

Rebuild triggers/journals data

This is passed as *NO, i.e. do not rebuild the data. (It the data has already been built then any triggers, journals or constraints will be removed.).

Viewing Archive data

To see the records in CUSTSA1 library do the following:

· Click on the CUSCARE Application area to include the CUSTSA1 library created by XARCAREA command.

· Click on the CUSTSA1 Archive library to make it the default data library. This is reflected onto the status bar’s right most cell.

· Double-click on the Files sub-item under CUSCARE application area. This brings up the Work with objects dialog.

· Type is pre-selected as *FILE. Select Attribute as PF to restrict the object list to physical files only. Click on the OK button.

· The object list presented contains the files under the CUSCARE application area.

· Right-click on the CUSTS file and choose View Data. This opens the CUSTS file in X-Browse displaying the records.
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CUSTS grid

Note the records displayed are for Customer ACC1 and ACC2 only. This meets the filter criteria specified in X-Subset section above for CUSTS application area.

	Reinstate Archived records

Right click menu option, Reinstate, on a selected Archive library under the application area brings up a dialog showing the selected X-Ref Library, Application area and Archive library. Further it prompts the user to reinstate all records or tagged records in the specified archive library. If the request is successful, the message, “Reinstate” job submitted successfully, appears on the status bar.

The *ALL option simply reinstates all the records in the archive library back into the application data library.

The *TAGGED option reinstates only those archived records which have been marked for reinstatement. The next section explains how an individual or selected records can be reinstated.
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Reinstate Archived Files


Individual record reinstatement XE " Archive Reinstatement : Individual record reinstatement " 
Bring up the CUSTS grid showing archived record as explained earlier. To mark an individual record reinstatement

· Select the record on the grid.

· Click on the reinstatement button [image: image46.png]


 on the toolbar. This brings up a dialog, which prompts the user to either reinstate all the records or only the selected record in view, ACC3 in his case.

Click on the Reinstate from Archive button on the toolbar[image: image47.png]


. This brings up a dialog, which prompts the user to either reinstate only the selected record or all the records.

	If All Records option is checked, then all records will be marked for reinstatement.
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If filter has been applied on the grid, then only those records will be considered which fulfill the filter criteria.

X4WRKAPP Master Control

The X-Analysis Application overview (X4WRKAPP) interface can be used to initialise X-Analysis.

To use the product, the cross-reference information must be generated. The initialisation process takes care of setting-up of this cross-reference database. 

Work with X-Analysis/4 Applications

Type the command X4WRKAPP and press Enter. The following is presented.

Ensure that XAN4 library has been included in the library list.

  X-Analysis/4           Work with X-Analysis/4 Applications    Databorough Ltd.

  XARWKAPP                                                              08:19:52

                                                                     04 Jul 2001

  Enter options, press Enter.                                                   

  1=WRKMBRPDM 2=Change 3=Copy 4=Delete 5=Display 7=Notes 8=Libraries            

  9=Exclusions 10=App areas 11=Reports 12=Initialise 13=Build data model        

  14=Offline menu 15=Objects 16=Datamodel 17=I/F Files 18=Program standards   

     X-ref Lib   Text                            Company/division               

     XAN4CDXA    XAN4CDEM Tutorial System

     XAN4CDXW    Web demo application                                                                                    

  F1=Help   F3=Exit  F6=Add    F10=Cmd Line      F12=Cancel   F24=More Keys     

This has host of options which work on an application viz., add, change, delete, display, libraries, application areas, reports, etc.

Refer to X-Analysis Data Management User Manual for more on X4WRKAPP.

Journal Enquiry

Pre-requisites

Prior to viewing the journaled records, following need to be done:

· Create Journal Receiver using CRTJRNRCV, say in the name CUSFRCV in XAN4CDEM library.

· Create Journal using CRTJRN, say CUSFJRN in XAN4CDEM library.

· Start journaling using command STRJRNPF CUSF OMTJRNE(*OPNCLO), omitting Open and Close journal entries.

If a Journal is not created, then a message “Journal data files do not exist” is displayed at the status bar.
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Journal does not exist message

Having started the journaling on the PF, modify the record to see the previous record state as it changed.

Work with Journaled records

One of the striking features of X-Browse is that the record display offers viewing of a particular record’s history (journal records).

This is relevant to AS/400 data files, which have been journaled.

The record display has four options to facilitate browsing the history. They are:

	Previous Journal Entry

Previous Journal entry button brings up the single record display of the previous journal entry (with reference to the journal entry currently displayed in the single record display).
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	Next Journal Entry

Next Journal Entry button brings up the single record display of next journal entry (with reference to the journal entry currently displayed in the single record display).
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	Journal Grid

Journal grid button displays all the journal entries of the record in the form of a table on the lower half of the display. Anyone of these entries can be selected for viewing in the Single Record view by double clicking the row.
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	Single Record Display

Single Record display button takes the user to current function’s Single record display from the journaled one.
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To see this working, do the following:

· Invoke X-Browse on CUSF from DMD above. Put off Dependents from View menu, if displayed.

· Ensure that CUSF has journaling started on it.

· Opt for Sites by Name from LookupBy menu.

· Double click on Acoustical Turbines Ltd. This takes you to it’s single record display.

· Click on Previous Journal entry. The journaled record, if exist, is displayed.

· If Journal Grid button is clicked, grid of jounaled records is presented below the single record display.

· If no records are displayed, the journal record buttons get disabled. We need to update the selected record to create journaled record(s).

· Change the Sts of the selected record from 9 to 1. Click on the Update button.

· The journal buttons are now enabled. Click on Previous Journal entry button. This presents the current record state. Note the Sts data is in red with current value - 1.
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Current record state

· Click on Previous Journal entry button again. This presents the previous record state. Note the Sts data is in red with old value - 9.
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Previous record state

· Click on Journal Grid button. This presents the grid of previous records.
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Grid showing jounaled records

· Click on the Single Record display button to return to current state.

· Exit X-Browse.
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This brings us to the end of the X-Analysis Data Management Tutorial.








































































































































© Copyright Databorough, Ltd. 1989, 1992, 1993, 1994, 1999


Version 2.7

© Copyright Databorough Ltd. 2005



[image: image59.png]


[image: image60.png]


[image: image61.png]


[image: image62.png]


[image: image63.png]


[image: image64.png]


[image: image65.png]


[image: image66.png]


[image: image67.png]


_1163234629.doc
[image: image1.png]Orphaned Record Report for SubSet Data Library CUSTSS1

Fie [ Gurer [ Primary Ke; [ Foreign ke
CONDET  CONHDR  elalionship veried
CONHDR  CUSTS Rlationship veified.
CONHDR  SLMEN Rlationship veified.
cusF ASTATUS  Relatonship verfid.
cusF DISTS Rlationship veified.
cusF 0RGS Rlationship veified.
cusTs cusF Rlationship veified.
cusTs CUSGRP  Relationship verified
cusTs DISTS Rlationship veified.
cusTs SLMEN Rlationship veified.








_1173694042.doc
[image: image1.png]S X-Browse
File View Actions

pe

Job Name
Daie
Company
Disibutor
ES
Phone

Dependerts Design HistoyHelp

> 94

[z Use [
oo T oo
B a—
CEGE —

0us. N
Eun

Last O Date
Newt CrtDate

@

[oo-o0-00

N

[oo-00-00







_1173694069.doc
[image: image1.png]Fle View Actions Dependerts Design Histoy Help

L=18] ]

7 K% e > (@]9

Company [Bcoustical Turbines Ltd Cus. No. [77 1
Disbutor | e R |

s T — Lt CriDale [oosoao

Phone [EEGEE Nest Crt Date. [o0-00-00

JOBNAME [USER | DATE|  TME | CUSNO | CavE [ bcooE [ ouave [ status [ stsTar TELNO. [ £ [ LcTDAT | APDATE [ UsERNM sal

K1}

History and display

[XANACDEMT /CUSF

[ ANACDEMT 2/Z4CUSF 1921681701







_1162800979.doc
[image: image1.png]Fle Miew Actions Dependerts Design Histoy Hel

pe

Job Name
Daie
Company
Disibutor
ES
Phone

EEE> 9§ 9

ooz Use [
oo T oo
e —
CEGE —

0us. N
Eun

Last O Date
Newt CrtDate

1L

[oo-o0-00

[60-00-00







